
Starting Final Cut Pro 
 
Turn on the DVrecorder that has the firewire cable attached to the Mac first. 
Turn on the macintosh computer second 
Load a DV tape into DV recorder 
 
Loading a video into Final Cut Pro 
 
Double-click on the Final Cut Pro Icon 

 
The first screen you’ll see is the Final Cut Pro Desktop Layout 



:  
 
The top left window is called the browser.  
The browser shows two tabs: the project, which holds the files you will work with, and the effects tab, which 
holds video and audio effects.  

To the right of the browser you will see two windows: the viewer and the canvas. 
Both of these screens view your content, but in different ways. The viewer is used to view the original source clip, 
while the canvas shows your work on the timeline (what will be exported).  

Below these sections is located the timeline.  
This is where you will drag your video clips and assemble them into the main project. Here is where you will apply 
effects, edit, and position clips nonlinearly in your project.  



To the right of the timeline is a toolbox, which gives you various tools to move, edit, and tweak your work on the 
timeline.  

 
 
Under File – select  “New project.” 
 
We recommend naming and saving the project right away. 
To do this, click on “File” then select “Save As”  
In the save dialog box, type the new project name in the “Save As” text box. 
Create a new folder to save the project to by clicking on the “new folder “ button. 
Type in a name for the folder and click “OK” 
Click the “Save “ button to save the project. 
 
Next , At the top of FCP, use the menu bar to select File > Log and Capture.  
 



This opens up another window called Log and Capture.  
 

 
 
The Log and Capture screen is where you will view and import the clips on your source tape to the computer's 
hard drive.  
 
The left window pane contains a screen for viewing the footage on your tape, device control to play, stop, ff, and 
rr your digital tape and mark in / out buttons.  
 
The right window pane you’ll see the name of your project and you can give a specific name for what you are 
going to be capturing. If you entered “NNJI” in the description field and “scene1” in the scene field, your clip would 
appear as “NNJI_scene1” in the browser window. 
If you do not enter anything in those field then your clip would be named      “UNTITLED  0001” for the first clip 
and “UNTITLED 0002” for the next clip ,etc. 
 
 
When you see the message “VTR OK” in the left pane, under the picture from your video, you are ready to 
proceed. (unless it’s a VHS) 
 



Two Types of Capturing – the whole tape, and selected sections of the tape (what’s called Batch 
Capturing). 
 
For Capturing the Whole Tape 
1. Begin playing the tape using the play button on the DV/SVHS recorder, or  use the play button in the log and 
capture screen on the left side pane (by the way – Final Cut Pro needs about 5 seconds to get the tape to speed 
and start recording). 
 
2. Click the “Capture Now “ button on the right hand side at the bottom to start capturing the video and you’ll see 
the content of your video playing while the computer is importing the tape. 
 
3. Press the escape button on the Mac keyboard, to stop the capture, and press stop on the DV/VHS player. See 
below for instructions on saving (#4) 
 
Batch Capturing 

1. Use the device control on the left pane to queue your tape to where you would like to start capturing the video. 
Once you have located the starting point for capture, click on the "mark in" button (or the "I" on your keyboard) to 
record the timecode (the tape's position) for the in point. Then, move the playhead (via the keyboard, buttons, or 
playhead located directly below the screen) to where you want the captured clip to end. Press the "mark out" 
button (or the "O" on your keyboard).  

You can also use keyboard shortcuts to run through your tape. Use the spacebar to play or pause the tape. Use 
the "J" key to rewind (tap once for 1x, twice for 2x), the "L" key to play normally (tap twice to fast forward), and the 
"K" key to stop the player. 

2. Once you have your in and out points, click on the "Log Clip" button located right of the device controls. You 
will be prompted to name your clip.  



 

 
 
Type in a descriptive name for the clip and select OK. Repeat the logging process until all the clips on your tape 
have been logged with in and out points, and named. 
 

Once this is completed, you will notice that you can see your clips in the browser. They will show with a red line 
through a clip icon to the left. This means that your clips are offline, or not yet captured. 

  

Offline means that you have entered the timecodes for the clips, but have yet to actually capture the data to your 
hard drive.  

To do so:  

• click the "batch" button in the bottom-right corner of the Log and Capture screen.  
 

• A menu will pop up.  



• From the top drop down box, select "All Items in Logging Bin" then select OK. 

 

 
The computer will then automatically move the camcorder to the first position marked and start capturing the film 
to the hard disk.  

Take this time to relax, take a break. FCP will capture all the clips you have created for you without any 
assistance. You’ll notice that the red line in your browser for the clip has gone away. 

4. Now save what you’ve captured. 

Now that you have imported the clips you wanted, close the Log and Capture window 

You can also import files into a project. These files can items like extra video, images, or audio. 
 
To import files – like still pictures, songs, etc.  

• Go to File > Import > Files...  
• Use the finder to select the file you wish to use 

Click on what you want to import or Click and hold the SHIFT, or the COMMAND button to select more than 
one file  

• Select Choose  

Your files will now appear in the Browser alongside your video. 
Save what you have imported. 



                       Editing Video Clips  

• You can use the left and right arrows on your keyboard to movie the clip frame-by-frame allowing those 
finely cut clips.  

To start off, find the clip that you would like to put at the beginning of your project.  
  

Two Ways of Moving the Clip to the Timeline. You can select portions of your clip in the Viewer first and then 
move the selection to the Timeline or you can move the entire clip to the Timeline and cutaway what you don’t 
want.  
 
1A. If you use the Viewer method - double click the clip in the browser so that it appears in the viewer. Then use 
the mark in and out points ("I" and "O" on your keyboard) to define the area you want to use. Then click in the 
center of the viewer and drag down to the Timeline 
 

1B. If you use the Timeline method – select and drag the clip to your timeline.  
 
Drag the clip to the right of the V1 line on the Timeline     

   

You’ll see a ghosting box move as you drag the clip to the Timeline and when you position the dragging to the 
right of the V1 you’ll see the ghosting box become bigger and rectangular and this represents one track of video 
and two tracks (L&R) of audio. When you release the mouse button you will see the one track of video locate itself 
on the V1 line and the two tracks of audio fall on the A1 + A2 lines.       Hit Save 
 



Your mouse pointers position relative to this line determines whither you insert or overwrite the clip in the time 
line. 
 
Insert:        with an insert edit, Final Cut creates new room on the time line track for your  
                    clip so that it doesn’t copy over other clips. 
 
Overwrite: When you do a overwrite edit, Final Cut adds your clip to the time line  
                     If the clip is long enough to run into another clip that is already on the track, 
                     The new clip erases that part of the old one. 
 
 
                Creating and adding text to a video 
 
Click on the effects tab in the browser window. 
Click on the small triangle net to the video generators bin and open the text sub-bin, which contains the text 
generators. 
Double click on the generator called text (which looks like a small clip with some colours on it) to open it in the 
viewer. 
Click on the controls tab on the viewer. 
Replace “Sample text” with what you want to display 
Adjust the other setting (font, size style, ect) as desired. 
Any changes will be shown when you select the video tab. 
When the text is the way you want it, click on the video tab and select the duration of the text. 
 By default, all generators create a clip of text that lasts 10 seconds. 
To change this setting, Highlight the time code in the duration field (located in the upper left corner) and type in a 
new duration. 
The next step is to add the text to the time line. 
There are two ways to do this. 
 
Superimpose over video:                         To superimpose the text clip over a video clip,      
                                                                    first make sure that the time line play head 
                                                                    (the vertical line in the time line That shows 



                                                                     the play position ) is over the clip. 
                                                                     Next drag the generators text from the viewer  
                                                                     to the canvas window and then select the 
                                                                     superimpose option from the edit overlay that 
                                                                     appears over the canvas. 
                                                                     The superimpose edit places the text in a new  
                                                                     video track above your video clip. 
                                                                     Final cut adjust the duration of your text to  
                                                                     match that of the underling video clip 
 
Appearing over a black back ground:      If you want the text to appear over a black  
                                                                      background, you can drag the text from the  
                                                                      viewer down to a video track on the time line 
 
 
                 Adding transitions to the Video 
 
 
In the browser window, click on the Effects tab. 
Click the small triangle next to Video Transitions. 
Open a transition bin and drag a desired transition to an edit point on the time line (the place where two clips 
meet). 
Hold down the Control key on the keyboard and click on the transition on the time line. 
Make sure that your clicking on the transition itself and not on the edit point. 
Choose duration from the pop-up menu that appears. 
In the duration dialog box,type a new duration and click OK. 
 
 
                        Rendering  the Sequence 
 
To do this, Double click on the sequence then click on “Sequence” (on the top of the screen) and select “Render 
Selection” then select “Both” 



You need to render the video before some of the preview will work or are able to output the video to a tape or 
DVD. 
 
 
 
 
 
 
                  Recording Video to a Tape 
 
Place a tape into to DV/SVHS recorder. 
To send the video from the Firewire connector to the SVHS drive then press the � button on the DV/SVHS deck. 
Press the button for the tape you are using (the button will light up when selected) 
Click on “File” and select “Print to Video” 
Select your options in the Print to Video dialog boxand click “OK”. 
When Final Cut displays a message that it is OK to start recording, press record on the DV/SVHS deck. 
If your using SVHS wait for the video calibration to end ,then click OK in the dialog box to start recording. 
 
When the recording ends, Write the title of the video and the run time on the label of the tape. 
 
 
 
                    Shutting Down the System 
 
Save all open files (click on “File” and select “Save”. 
Click on “Final Cut Pro” and select “Exit Final Cut Pro” 
Click on the “Apple logo” and select “Shutdown” 
 
 
Video tab: Displays the video image, including visual modifications made to the clip 



 
 

Audio tab: If a clip within the viewer has audio, an audio tab will be displayed. The audio tab displays the audio waveform of a clip. Audio 

adjustments to the level and pan can also be made in this window. 

 

Motion tab: Shows a list of motion parameters that can be adjusted for the clip. 

 
 

Control tab: This tab will not be shown, unless you are working with an effect loaded from the video generator, or a title. 

 

VIEWER CONTROLS 



 
 

At the bottom of the viewer window, there is a play button that must be pressed to view a video clip in full motion. Pressing the play button again 

will stop a clip from playing. 

Pressing the spacebar also will play/stop your timeline clip. 

There are some important keyboard shortcuts that allow you to easily play clips without having to use the viewer controls. 

 

L key - Plays forward (pressing the L key again will play the clip at 2X, 4X, and so on) 

 

J key - Plays backward (pressing the J key will play the clip at 2X, 4X backwards, and so on.) 

 

K key - Stops playing (holding down the K key while playing forward or backward will play in slow motion) 

 

Space Bar Toggles between stop and play 

 

Left / Right arrows: moves the position indicator 1 frame forward or backward 

 

Shift + (Left or Right arrow): moves the position indicator 1 second forward or backward 

 

TRACK LABELS 



 
Visibility: Simply means whether or not you are actually able to see what is on a specific track. You can relate this to turning off your television 

set, even though the VCR is playing. 

 

Target: When you begin editing, it signifies where clips will be placed on the timeline if you have multiple video or audio layers. In Final Cut Pro 

5.0, Targeting a specific track is done by patching a source track on the left to the target track on the right. 

 

Track Lock: Prevents a track from being edited or changed.  

 

You can adjust the track height by clicking on the 'Timeline Track Height' icon located in the bottom left corner of the timeline window. 

 
 

At the bottom portion of the timeline window, there is a zoom slider bar. Dragging either end of the slider will allow you to zoom in and out of a 

sequence. The center portion of the zoom slider bar shows the area of the sequence being displayed. Dragging the center area of the zoom slider 

allows you to move to a new area. 

 

 

 

EDTIORS NOTE: 

Final Cut Pro offers an alternative way to zoom in and out of your timeline window. Using the keyboard combination of (Option + / -) will zoom 

in or out of the timeline window. Notice, by continuing to zoom in, you will evenutally be able to see one frame. 

 

 

One invaluable shortcut you'll want to remember when using Final Cut Pro, is the ability to scale your entire sequence within the timeline 

window. To fit the entire sequence within the boundaries of the timeline window, use the keyboard shortcut (shift + Z). 

 



THUMBNAIL DISPLAYS IN THE TIMELINE 

 
Final Cut Pro supports the use of picture thumbnails within the clips in a sequence. Sometimes, it may be beneficial to add these picture icons 

within your sequence. It serves as a good visual aid when editing. 

 

To turn on the thumbnail images in Final Cut Pro, go ahead and highlight the timeline window and navigate to the Sequence | Settings menu. (or 

use Apple + 0) A sequence settings box will appear.  

 
 

STORYBOARD EDITING IN THE BROWSER 

 

Final Cut Pro allows you to create a storyboard, which is a very visual style of editing. It involves dragging and dropping clips directly from your 

browser window to the timeline window. It has its advantages and disadvantages. 

 

Control click in the browser window and select View as Large Icons. Final Cut Pro will display all of your clips as large picture thumbnails.  

 

After you have arranged your clips in the browser window, you can select all of them and drag them to the timeline window. You can also use the 

keyboard shortcut (Apple + A) to select all the clips within the Browser window. 

 


